~ Arduino Learning Guide
For Beginners

MAKER UNG




I'm Bng Tong from Cytron Techvologies. T wrote this guide with vou in mind - a
student (or +eacher), learning Arduivo for the first time.

wWhen I first started learving Arduino, T discovered that there were lots of
documents, learning auides and +tutorials available on the Tntervet - and irovically,
that was my biggest problem! There were simply too many that I had vo idea
where to start and which ove to refer to.

And mawny of the learning guides that claim +o be crafted for beainers are just
too superficial - most of the time, they ouly show you the schematics, give vou the
sample code and tell you what to expect but they do not explain how i+ works.

It's very frustrating for people like me who do ot have C-programming
background. Although T can achieve the expected ontcomes by following the
schematic and copying the code given, T'w pretty sure T will vot be able o create
my owu projects even after I've completed all the lessous.

Furthermore, T observed that most of the learnivg guides were writtew by
techies who tend o assume certain thivgs to be understood. In other words,
foundational knowledge is not covered and what is presented is too +echnical for a
begivmer o understand.

There's nothing special with the projects in this learning guide. Basically, T just
added explanation on some aspects that T initially struggled with and T also
simplified the techvical part for better widerstavding. I sincerely hope that
begivmers can bevefit from this learning guide and evjoy learning Arduino.

Chheers,

A

Tan Eng Tong
Co-founder and CEO
Cytron Technologies
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LESSON O
SETTING UP
HARDWARE

& SOFTWARE




1. Peel off the labelling stickers and attach them to the pin headers as

shown below.

2. Take out the breadboard, remove the
attach it to the Maker UNO X board.

adhesive backing and then

+00000 00000
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@

Connect Maker UNO X to your PC with a micro USB cable.

Part 2: Download & Install Arduino IDE

Go to https://lwww.arduino.cc/en/main/software.

2. Choose your OS to proceed.

- o

@ Y Incognito €@

HOME STORE SOFTWARE EDU RESOURCES COMMUNITY HELP q i SIGN IN

Download the Arduino IDE

ARDUINO 1.8.10

The open-source Arduino Software (IDE) makes it easy to

write code and upload it to the board. It runs on
Windows, Mac OS X, and Linux. The environment is
written in Java and based on Processing and other open-
source software.

This software can be used with any Arduino board
Refer to the Getting Started page for Installation
instructions.

Windows Installer, for Windows XP and up
Windows zip file for non admin install

Windows app Requires Win 81 0r 10
Get 52

Mac OS X10.8 Mountain Lion or newer

Linux 32 bits
Linux 64 bits
Linux ARM 32 bits
Linux ARM 64 bits

Release Notes
Source Code
Checksums (sha512)

For Windows Users, it is recommended to select Windows

Installer, for Windows XP and up.
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3. Arduino IDE is an open source software. Click “*JUST DOWNLOAD”
button to download and use for free.

w HOME STORE SOFTWARE EDU RESOURCES COMMUNITY HELP Q "] SIGN IN

Contribute to the Arduino Software

Consider supporting the Arduino Software by contributing to its development. (US tax payers, please note this contribution
is not tax deductible). Learn more on how your contribution will be used

SINCE MARCH 2015, THE ARDUINO IDE HAS BEEN DOWNLOADED

TIMES. (IMPRESSIVE!) NO LONGER JUST FOR ARDUINO AND
GENUINO BOARDS, HUNDREDS OF COMPANIES AROUND THE WORLD ARE
USING THE IDE TO PROGRAM THEIR DEVICES, INCLUDING COMPATIBLES
CLONES, AND EVEN COUNTERFEITS. HELP ACCELERATE ITS DEVELOPMENT
WITH A SMALL CONTRIBUTION! REMEMBER: OPEN SOURCE IS LOVE!

$10 $25 $50 OTHER

™

JUST DOWNLOAD CONTRIBUTE & DOWNLOAD Frivacy-Tems

Note: Users are encouraged to make a monetary
contribution to help them to continue funding the
development.

4. Double click on the downloaded file to proceed.

&

arduino-1.8.6-win
dows arduino-1.8.6-macosx.zip

For Windows For Mac

5. Once installation is completed, the Arduino icon will appear. Double
click the icon to launch Arduino IDE.

©.0,

Arduino
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L% Part 3: Download & Install Driver

For Windows Users:

1.Download the driver here:
https://cdn.cytron.io/makeruno/CH341SER.EXE

2.Double click the “CH341SER” file to begin installation.

ﬁélJSEF

CH3415ER

3.Click “INSTALL".

[ﬂg DriverSetup(X64) —

Device Driver Install / UnInstall

Select INF CH341SER.INF

WCH.CN
INSTALL | USB-SERIAL CH340

|__ 08/08/2014, 3.4.2014

UNINSTALL

HELP

4 .Click “OK”.

c

Device Driver Install / UnlInstall

Select INF |\CH341SER . INF
DriverSetup

INSTALL 1o

- y , 3.4.2014
UNINSTAL Driver install success!
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5. Click on Windows Search icon |8 and search for “Device
Manager”.

All Apps Documents Email Web More ¥

Best match

? Device Manager
"' Control panel ol
Search the web )
Device Manager
£ Device Manager - See web results Control panel

Photos

[N device manager - in MU beginner kit
images

[N device manager - in ET's images

AP Device Manageli

6. Click to expand “Ports (COM & LPT)”. Check which port the CH340
driver has been assigned to. Take note of the COM number (for
example, the driver is linked to my COM3).

A Device Manager

File Action View Help
a2 m B Hel B

~ &% LAPTOP-P8BL6C3D
i Audio inputs and outputs
}é Batteries
| Biometric devices
B Bluetooth
® cameras
= Computer
= Disk drives
@ Display adapters
I Firmware
Vg Human Interface Devices

= Keyboards

@ Mice and other pointing devices
@ Monitors

I Network adapters

W Ports (COM & LPT)

W USB-SERIAL CH340 (COM3)
= Print queues
n Processors

B Security devices

f Software components

B Software devices

iy Sound, video and game controllers
S Storage controllers

Em System devices

B iInivarcal Carial Rie rantrallare

Your Maker UNO X needs to be connected to your PC.
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7. Launch Arduino IDE. Go to Tools > Ports > COM_ Select the right
COM port.

@ sketch_nov28a | Arduino 1.8.10
File Edit Sketch Tools Help
Auto Format Ctrl+T
Archive Sketch
sketch_nov28z Fix Encoding & Reload
Manage Libraries... Ctrl+Shift+I
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

void setu
// put

} WiFi101 / WiFiNINA Firmware Updater

Board: “Arduino/Genuino Uno® >
void loop Port: "COM3" b Serial ports

// put Get Board Info - COM3
Programmer: “AVRISP mkil* > W

Burn Bootloader

For Mac users:
1. Download the driver here:
https://cdn.cytron.io/makeruno/CH341SER MAC.ZIP

2. Double click the zip file, open the unzipped folder and then double

click the pkg file.

CH34x_Install_V1.
4.pkg

Click “CONTINUE” to begin installation.

] « Install CH34x_Install

Welcome to the CH34x_Install Installer

Welcome to CH341 and CH340 usb to serial device driver

@ Introduction installation program.
This program instal the driver to the default directory of the system ,
Destination Select do not change it.
Also this installation only support CH341 and CH340 .

Installation Type
Installation

Summary

Continue

@7
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4. Once done, click “Restart”.

@ « Install CH34x_Install

The installation was completed successfully.

Introduction
Destination Select
Installation Type

Installation

Summary The installation was successful.

The software was installed.

Click Restart to finish installing the software.

5. After you've restarted your Mac, launch Arduino IDE. Go to
Tools > Port > /dev/icu.wchusbserial1410

@ Arduino File Edit Sketch Help
® o Auto Format ®T sketch_aug27a | Arduino 1.8.5

Archive Sketch
Fix Encoding & Reload
sketch_augz7a Serial Monitor O ¥M

4 Setnl) { Serial Plotter o8

/4 put your setup code here, to ru

WiFi101 Firmware Updater

Board: "Arduino/Genuino Uno"

Get Board Info [dev/cu.HM-12T-SerialPort-7
fdevfcu.JBLGO-vCOMM-1
/dev/cu.Bluetooth-Incoming-Port
/devjcu.rerg-SerialPort-11
Jdevjcuwchusbserial1410

Programmer: "AVRISP mkil* >
Burn Bootloader

Note: If you have problems installing the driver,
please follow the troubleshooting steps here:
https://cdn.cytron.io/makeruno/Troubleshooting__
CH431_Driver_For_Mac.pdf
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LESSON 1
DIGITAL OUTPUT



L5 Project 1: Turn On An LED

Connect your Maker UNO X to your PC with a micro USB cable.

2. Launch Arduino IDE and you will see the following new sketch.

sketch_dec03a | Arduino 1.8.10
File Edit Sketch Tools Help

sketch_dec03a

void setup() {
// put your setup code here, to run once:

void loop() {
// put your main code here, to run repeatedly:

Simplifying Digital Making




3. Write this code into your sketch and then click this button ' to
compile your code. Wait for a few seconds until you see “Done
Compiling” appear at the bottom of the sketch.

_

void setup() {
// put your setup code here, to run once:
pinMode(7, OUTPUT);

}

void loop() {
// put your main code here, to run repeatedly:
digitalWrite(7, HIGH);

}

If error occurs, check and correct your code line by line, and then
compile again.

v Arduino is case sensitive - make sure you use uppercase for
OUTPUT and camel case for pinMode and digitalWrite (i.e. use
capital letters for M and W).

v" Check to make sure you have not missed out any signs -

; » ()and {}.

v" Do not mix up normal brackets () with curly braces { } .

Simplifying Digital Making




Next, click {"¥ button to upload. Uploading will start immediately.
Once completed, you will see “Done Uploading” appear at the
bottom of the sketch.

Slide the switch to turn on the “Debug” mode. Check your result.

e
ninihin
OSRBnSw

You can see that LED 7 is lighted up
while the rest of the LEDs are off.

=)
r=
|

"
-
-
=]
=
=
=
|

O grEirfririci- i
NEwEABuEaly Rwlv

If error occurs while uploading, please ensure that your Maker
UNO X is connected to your PC and the correct port is selected
(Tools > Port > COM_ ).

Remember to turn on the “Debug” mode to enable the built-in
LEDs on Maker UNO X.
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Project_1

void setup() {
// put your setup code here, to run once:

(7, ) This line tells the board to set pin 7 as

} output.

void loop() {
// put your main code here, to run repeatedly:

(7, ) This line tells the board to set pin 7 to

HIGH (i.e. to turn on).

ARDUINO FUNCTION

1. To set a pin as input or output:
pinMode (pin, mode)
pin: the number of the pin you are setting
mode: INPUT, OUTPUT, or INPUT_PULLUP

2. To set a digital pin to HIGH (on) or LOW (off)
digitalWrite(pin, value)
pin: the number of the pin you are setting
value: HIGH or LOW
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Project 2: Blink An LED

. Modify your code in Project 1 to the following:

Project_2

void setup() {
// put your setup code here, to run once:
pinMode(7, OUTPUT);

}

void loop() {
// put your main code here, to run repeatedly:
digitalWrite(7, HIGH);
delay (100);
digitalWrite(7, LOW);
delay (100);
}

Compile and upload your code to your Maker UNO X.

Check your result.

] I
Click here or scan

QR code to watch
the demo video.

E ™! E LED 7 will be blinking continually while the
rest of the LEDs are off. =

-
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4. Change the delay value to 1000 and then upload to your board again.

Project_2

void setup() {
// put your setup code here, to run once:
pinMode(7, OUTPUT);

}

void loop() {
// put your main code here, to run repeatedly:
digitalWrite(7, HIGH);
delay (1000);
digitalWrite(7, LOW);
delay (1000);
}

Observe the result and compare with the previous program. Can you
tell the difference?
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Project_2

void setup() {
// put your setup code here, to run once:

(7, ; This line tells the board to set pin 7
} as output.

void loop() {
// put your main code here, to run repeatedly:

(7, ); Turn on LED 7
(1000); Hold for 1000ms The program

will continue
to loop

(7, : Turn off LED 7 endlessly.
(1000); Hold for 1000ms

ARDUINO FUNCTION

1. To hold or pause the program
delay(ms)
ms: the number of milliseconds to pause
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L5 Project 3: Blink the LEDs in Sequence

In this project, we want to blink LED 2, LED 3, LED 4, LED 5, LED 6 and
LED 7 in sequence.

1. Modify your previous code to the following:

Project_3

void setup() {

pinMode(2, OUTPUT);
pinMode(3, OUTPUT);
pinMode(4, OUTPUT);
pinMode(5, OUTPUT);
pinMode(6, OUTPUT);
pinMode(7, OUTPUT);

}

void loop() {
digitalWrite(2, HIGH);
digitalWrite(3, HIGH);
digitalWrite(4, HIGH);
digitalWrite(5, HIGH);
digitalWrite(6, HIGH);
digitalWrite(7, HIGH);
delay (1000);
digitalWrite(2, LOW);
digitalWrite(3, LOW);
digitalWrite(4, LOW);
digitalWrite(5, LOW);
digitalWrite(6, LOW);
digitalWrite(7, LOW);
delay (1000);

}

2. Compile and upload your code to your Maker UNO X.

Simplifying Digital Making




3. Check your result. Is it the desired outcome?

}

f
Click here or scan

QR code to watch

the demo video.

~

LED 2 to LED 7 turn on and then turn
off together; which is NOT the effect
that we want. Why?

Set Pin 2 to Pin 7 as output.

Turnon LED 2to LED 7

Hold for 1000ms.

Turn off LED 2 to LED 7

Hold for 1000ms.
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Modify your code to the following.

Project_3

void setup() {

pinMode(2, OUTPUT);
pinMode(3, OUTPUT);
pinMode(4, OUTPUT);
pinMode(5, OUTPUT);
pinMode(6, OUTPUT);
pinMode(7, OUTPUT);

}

void loop() {
digitalWrite(2, HIGH);
delay (1000);
digitalWrite(3, HIGH);
delay (1000);
digitalWrite(4, HIGH);
delay (1000);
digitalWrite(5, HIGH);
delay (1000);
digitalWrite(6, HIGH);
delay (1000);
digitalWrite(7, HIGH);
delay (1000);
digitalWrite(2, LOW);
delay (1000);
digitalWrite(3, LOW);
delay (1000);
digitalWrite(4, LOW);
delay (1000);
digitalWrite(5, LOW);
delay (1000);
digitalWrite(6, LOW);
delay (1000);
digitalWrite(7, LOW);
delay (1000);

}
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3. Check your result. Is it the desired outcome?
N

Click here or scan
QR code to watch
the demo video.

Now the LEDs will turn on one by one and
then turn off one by one.

void loop() { void loop() {
digitalWrite(2, HIGH); digitalWrite(2, HIGH);
digitalWrite(3, HIGH); delay (1000);
digitalWrite(4, HIGH); digitalWrite(3, HIGH);

digitalWrite(5, HIGH); delay (1000);
digitalWrite(6, HIGH); digitalWrite(4, HIGH);
digitalWrite(7, HIGH); delay (1000);
delay (1000); digitalWrite(5, HIGH);
delay (1000);
digitalWrite(6, HIGH);
delay (1000);

digitalWrite(7, HIGH);
m delay (1000);

Although both versions of the code will turn on the LEDs, the results
are different. In Version 1, you will see as though all the LEDs light up
at the same time.This is because the lines are executed line by
line in quick succession (in less than 1 micro second).

To get the LEDs to light up one by one in sequence, we need to add
a delay after lighting up each LED (as in version 2 code).
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Task: Program LED 2 to LED 13 to execute the blinking pattern as shown
in the demo video below.

Click here or scan
QR code to watch
the demo video.

AL

CONGRATULATIONS! You have completed Lesson 1 and learnt the
following:

1. How to set pin as digital output

2. How to set a digital output pin to HIGH and LOW
3. How to use delay function

Simplifying Digital Making




LESSON 2
DIGITAL INPUT



L5 Project 4: On-Board Push Button Switch

In this project, we want to control an LED using the on-board push button
switch.

1. Open a new sketch and then write the following code.

Project_4

void setup() {
pinMode(4, OUTPUT);
pinMode(2, INPUT_PULLUP);

}

void loop() {
if (digitalRead(2) == LOW) {
digitalWrite(4, HIGH);
}
else {
digitalWrite(4, LOW);
}
}

2. Compile and upload the program. Check your result.
)

Click here or scan
QR code to watch
the demo video.

E E LED 4 will light up when the push
n button is pressed. —

@ I
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Project_4
void setup() {

(4, ' Set Pin 4 as output.
(2, B Set Pin 2 as on-board switch input.

}

void loop() {

i Read Pin 2. If it is LOW (switch is

pressed),
} : set Pin 4 to HIGH (turn on LED 4).
else { Else (switch is not pressed),

; set Pin 4 to LOW (turn off LED 4).

}
}

ARDUINO FUNCTION

1. To use the on-board push button switch, we need to set it as
internal pullup input.
pinMode(2, INPUT_PULLUP);

The on-board LED at Pin 2 can act as an input indicator when
you turn on Debug mode. LED 2 will be turned off whenever the
on-board switch is pressed.

The on-board switch is internally connected to Pin 2. Meaning it

is occupied and cannot be connected to any other external
components when it is in use.
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CODING SYNTAX
1. To use the “if-else” statement

if (condition 1) {
// do thing A

}

else if (condition 2) {
// do thing B

}

else {
// do thing C

}

2. We can use /I (two adjacent slashes) to leave a reminder or
comment while programming. Anything written after this sign will
be ignored by the program and will not be executed.

Il your comments here
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L5 Project 5: External Push Button Switch

In this project, we want to construct a basic circuit of an external push
button switch.

Get these components.

Push button switch 10K ohm resistor

2. Construct the circuit as shown below.

e ~ % 0 —n g
<+ DEBUG
4 g = =

N

PIEZO 3.3VREG|

. MAKER »
2 UNO Xum 9

ATMEGA
3857

= TOREF
RESET

www.cytron.io

Ciions

-
TXOP L=
RX0 40 -

v
®e === . sscssses
CyfI’Oﬂ s In collaboration with
Technologies

chmbaka QRIS A

fritzing
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Press the external push button switch. Observe LED 3 whether it is
on before you press the switch and goes off when the switch is
pressed. If it is not working, please fix your circuit before you proceed
to the next step.

fritzing

4. Modify your Project 4 code to the following, and then upload to your
Maker UNO X.

Project_5

void setup() {
pinMode(4, OUTPUT);
pinMode(3, INPUT);

}

void loop() {
if (digitalRead(3) == LOW) {
digitalWrite(4, HIGH);
}
else {
digitalWrite(4, LOW);
}
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3. Check your result.

~

Click here or scan
QR code to watch
the demo video.

E L E When the external push button switch is
|_ pressed, LED 4 will turn on. -
[=] ,.ﬁ
\ J

Project 5

void setup() {

(4, ' Set Pin 4 as output.
(3, ; Set Pin 3 as input.

}

void loop() {
( Read Pin 3. If it is LOW (switch is

pressed),
set Pin 4 to HIGH (turn on LED 4).

Else (switch is not pressed),
set Pin 4 to LOW (turn off LED 4).
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ARDUINO FUNCTION
1.

you can use it.

1

Switch is an input device; you need to set that pin as input before
pinMode(pin, INPUT);
BASIC ELECTRONICS

Breadboard's internal connectivity.

2.

circuit.

Arduino

10K ohm
resistor

5V
N

For any digital input, you can make it as a “pull-up” or “pull-down”

+
G

D

Arduino

It is HIGH when the

switch is not pressed.

10K ohm
resistor
GND
In this project, we used “pull-up” circuit. You can choose to use
change the code accordingly.

It is LOW when the
either type of circuit for your future projects but remember to

switch is not pressed.
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Task: Use both on-board and external switches. When both switches are
not pressed, both LED 4 and LED 5 will be on. If the on-board switch is
pressed, LED 4 goes off. If external switch is pressed, LED 5 goes off.

Click here or scan
QR code to watch
the demo video.

CONGRATULATIONS! You have completed Lesson 2 and learnt the
following:

1. How to read digital input signal.

2. How to control an LED using a switch.

3. How to construct a simple pull-up / pull-down
circuit.
How to use if-else statement.
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LESSON 3
ANALOG OUTPUT



L5 Project 6: Construct an LED Circuit

In this project, we are going to construct a simple circuit with one LED.

Get these components.

220 ohm resistor

2,

- OFF .
<+ DEBUG
4 [

3.3vREG| © @

. MAKER
ZUNONS o
N

CH34DC  AREF =
GND

PEL ra

12 - ria
~1l - r4
~10 -
~qm i

www.cytron.io

-

7= ra

- ra

- ra

~3m r4

Ciions

2 = ra
ICSP w TXOP L=
s = RX040 -

oo .l . s000s000
CyfI’Oﬂ s In collaboration with
Technologies

chmbaka QRIS A

fritzing
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3. Write and upload the following code to your board.

Project_6

void setup() {
(2, INPUT_PULLUP);
(5, OUTPUT);

}

void loop() {
if ( (2) == LOW)
while (1) {
(5, HIGH);
(200);
(5, LOW);
(200);

(5, LOW);

4. Check your result.

\
Click here or scan

QR code to watch
the demo video.

Both on-board LED and the external LED at
Pin 5 will blink after the on-board switch is
pressed. LED 5 will not stop blinking unless
the reset button is pressed.
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Set Pin 2 as pull-up input switch.
Set Pin 5 (connected to external LED)
as output.

Read Pin 2. If it is LOW (switch is
pressed), set Pin 5 to HIGH for 200ms
and then LOW for 200ms.

*Once Pin 2 is pressed, the LED will
blink continually and it will not stop
unless the reset button is pressed.

Else if switch is not pressed, set Pin 5
to LOW (LED connected to Pin 5 will
not light up).

BASIC ELECTRONICS N . -

1. Light emitting diode (LED) has 2 legs. You avop canion

need to connect the longer leg to the + terminal
and the shorter leg (flat edge on the casing) to
the - terminal. +
An LED is polarised. It must be connected in the
+

right direction; otherwise, it will not work.
71

-
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2. Aresistor is not polarised, thus
you can connect the pins in any
direction.

3. The colour bands on a resistor
tell us its value. You can refer to
this chart to understand how to
read the value.

CODING SYNTAX

Example: 220Q +/- 5%

Ilst DigitI Ian DigitI IMuItipIierl |TOIerance|

A while loop will loop continuously, and infinitely, until the expression

inside the parenthesis () becomes false.
while (condition)
{

/I do something

}

Example:
1. Do something for 200 times.
var = 0;
while (var < 200)
{
/I do something
var++;

}

2. Do something endlessly.
while (1)
{

/I do something

}
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£33 Project 7: Fade An LED

1. Using the same circuit as Project 6, write and upload the following
code to your board.

_

void setup() {
pinMode(5, OUTPUT);

}

void loop() {
analogWrite(5, 60);
delay (200);
analogWrite(5, 50);
delay (200);
analogWrite(5, 40);
delay (200);
analogWrite(5, 30);
delay (200);
analogWrite(5, 20);
delay (200);
analogWrite(5, 10);
delay (200);
analogWrite(5, 0);
delay (1000);

}
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Check your result.

~
Click here or scan

QR code to watch
the demo video.

You will notice that the LED lights up and
then the brightness diminishes gradually
until they are completely off. This cycle
keeps repeating until you turn off the
power.

OO BEHA

Project_7

void Setu?S() { Set Pin 5 (connected to external LED) as

] : output.

void loop() {

(5, 60); Light up LED at brightness 60 for 200ms.

(200);

200} (5,50); Light up LED at brightness 50 for 200ms.

(200): (5, 40); Light up LED at brightness 40 for 200ms.

5, 30); : )
(200); ( ) Light up LED at brightness 30 for 200ms.

5, 20);
(200); ( ) Light up LED at brightness 20 for 200ms.

(5, 10);
(200); Light up LED at brightness 10 for 200ms.

(5, 0);
(1000); Turn off LED (brightness = 0) for 1s..




3. There is an easier way to achieve the same result. Modify your code
to the following and then upload to your board.

Project_7a

int brightness = 60

void setup() {
pinMode(5, OUTPUT);

}

void loop() {
analogWrite(5, brightness);
delay (200);
if (brightness ==0) {
delay (1000);
brightness = 60;
}
else {
brightness = brightness-10;

}
}

4. Check your result.

. ™
Click here or scan

QR code to watch
the demo video.

@ E_‘ Do you get the same result as earlier?
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\@’ How it WOrkS
OO0 BEE

Project_7a

g o

Define a variable (brightness) and
brightness = 60 assign an initial value of 60 to it.

void setup() { Set Pin 5 (external LED) as output.

}

void loop() { Light up LED at the current value
(5, brightness); assigned to the variable 'brightness'.
(200); Hold for 200ms.

(5,

) Check if the variable 'brightness' is
(brightness == 0) { equals to 0 (LED is turned off), then
(1000); wait for 1000ms and then reassign
brightness = 60; 'brightness' value to 60.
}
{ Else if brightness value is not 0, then
brightness = brightness-10; U seEIECRGISAVEIET IS o]ylo[altg IS RVE [V
to current value minus 10 (dim the
brightness of the LED).

ARDUINO FUNCTION

1. There are 2 types of outputs - digital and analog. A digital output
has only two possible values, either 0 (LOW) or 1 (HIGH). The
value for analog output can range from 0 to 255. You can use
the following function to control the analog output:

analogWrite (pin, value);
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2. However, not every pin on the board
can be used for analog output. Only pins
3, 5,6,9, 10 and 11 (indicated with the ~
sign) have analog output functionality.

ECEicicis i

CODING SYNTAX

1. The beauty of coding is allowing the programmer to
simplify a very long instruction into a few lines of code
that execute the same task.

Reducing the number of lines also helps to reduce the
processing time, thus it is very important to always
optimize your code.

In this project, we want to reduce the LED brightness
every 200ms. So we define it as an integer variable at
the beginning of the program. “Brightness” is just a

variable name; you can choose to name it anything you
like.

4. The following are comparison commands that you can
use in your code.

X ==y (x is equal to y)

x 1=y (x is not equal to y)

X <y (xis less thany)

X >y ( x is greater than y)

X <=y (x is less than or equal to y)

X >=y (x is greater than or equal to y)

Simplifying Digital Making




Task: Fade LED 5 only when the on-board switch is pressed.

2 ™\
Click here or scan

QR code to watch
the demo video.

[m] e [m]

E

[=]yn

-

CONGRATULATIONS! You have completed Lesson 3 and learnt the
following:

1. How to construct a basic LED circuit.
. How to use while loop.
3. The difference between digital output and analog

output.
The importance of reducing the number of

lines of code.
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LESSON 4
MELODY TONE



% Project 8: Compose Basic Tones

1. Open a new sketch, write the following code and then upload to your
board.

Project_8

void setup() {
pinMode(8, OUTPUT);

}

void loop() {

tone (8, 262, 250);
delay (325);

tone (8, 294, 250);
delay (325);

tone (8, 330, 250);
delay (325);

tone (8, 349, 250);
delay (325);

tone (8, 392, 250);
delay (325);

tone (8, 440, 250);
delay (325);

tone (8, 494, 250);
delay (325);

tone (8, 523, 250);
delay (1000);

}
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2.

Check your result.

Click here or scan
QR code to watch
the demo video.

[=] e [m]
[=].F

N

~

J

The buzzer will keep playing the basic
tones “Do Re Mi Fa So La Ti Do”
repetitively.

@ How it works

Q0O

Project_8

() {
(8,

}
void loop() {
(8, 262, 250);
(325);
(8, 294, 250);
(325);

(8, 330, 250);
(325);

(8, 349, 250);
(325);

(8, 392, 250);
(325);

(8, 440, 250);
(325);

(8, 494, 250);
(325);

(8, 523, 250);
(1000);

Set Pin 8 (connected to on-board piezo
buzzer) as output.

Play tone “Do” 262Hz for 250ms.
Play tone “Re” 294Hz for 250ms.
Play tone “Me” 330for 250ms.
Play tone “Fa” 392Hz for 250ms.
Play tone “So” 392Hz for 250ms.
Play tone “La” 440Hz for 250ms.
Play tone “Ti” 494Hz for 250ms.

Play tone “High Do” 523Hz for 1000ms.




ARDUINO FUNCTION

1.

To get the piezo buzzer to play a tone.
tone (pin, frequency, duration);
pin: the pin that is connected to the piezo buzzer
frequency: frequency of the note in hertz (Hz)
duration: the duration of the note in milliseconds (ms)

2. To distinguish the different notes in a melody, we need to add a

1.

delay between the notes. The delay has to drag 30% longer
than the note duration to fully play out the note. For example, if
the note duration is 250ms, we should add a delay of 325ms
(250ms + 75ms).

MAKER UNO X'S FEATURE

The on-board piezo buzzer is connected to Pin 8. You need to
switch on the DEBUG mode to activate the piezo buzzer.

If you want to connect Pin 8 to another I/O device, remember to
switch off the DEBUG mode to deactivate the piezo buzzer.
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READING MUSIC SHEET

1. The position of a music note on the staff (i.e. the five horizontal
lines) determines its tone. The higher the note sits on the staff,
the higher the frequency of the sound and vice versa. You can
refer to the following link to get the frequencies for all 88 keys on
the piano : https://www.arduino.cc/en/Tutorial/ToneMelody

Note F5| G5
Frequency|262(294|330|3491392|4401494| 523|587| 659|698 784

Different musical notations are used to tell us the duration (i.e.
how long) a note is to be played. In Arduino tone library, the
duration to play a quarter note (1 beat) is 250ms; assuming that
one whole note is played for 1 second.

Length Note Note

Note Note Note
Beat(s) 4 2 1 1/2 1/4

Duration(ms)

Relative ‘Whole Half ‘Quarter Eighth | Sixteenth
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% Project 9: Compose "Happy Birthday” Melody

Let's compose the first line of “Happy Birthday” tune.

1. Modify your previous code into the following and then upload to your
board.

_

void setup() {
pinMode(8, OUTPUT);
tone (8, 392, 125);
delay (163);

tone (8, 392, 125);
delay (163);

tone (8, 440, 250);
delay (325);

tone (8, 392, 250);
delay (325);

tone (8, 523, 250);
delay (325);

tone (8, 494, 500);
delay (650);

}
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Check your result.

.

~
Click here or scan

QR code to watch

the demo video.

=] 54
E' L.
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The buzzer will play the first line of “Happy
Birthday” tune one time.

@ How it works

OO BHEE

Project_9

void setup() {

(8,
(8,392, 125);
(163);
(8,392, 125);
(163);

(8, 440, 250);
(325);
(8,392, 250);
(325);
(8, 523, 250);
(325);
(8, 494, 500);
(650);

Set Pin 8 (connected to on-board
piezo buzzer) as output.

Play tone 'G4' 392Hz for 125ms.

Play tone 'G4' 392Hz for 125ms.

Play tone 'A4' 440Hz for 250ms.

Play tone 'G4' 392Hz for 250ms.

Play tone 'C5' 523Hz for 250ms.

Play tone 'B4' 494Hz for 500ms.
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CODING SYNTAX

1. Did you notice that Project_9 melody only plays once and it
doesn't keep repeating like in the previous project?

This is because the entire code is written under void setup()
instead of void loop(). In other words, the code will be executed
line by line upon powering up Maker UNO X and will not be
repeated again unless the reset button is pressed.

Sketch

setup() {

// put your setup code here, [EBlRIER IR0 AN AL Rt Xl
to run once: when reset button is pressed)

}

loop() {
// put your main code here, [EBSRUISHIETLEICT\AUTglilNelel Tl
to run repeatedly: off or reset button is pressed)

}
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L35 Project 10: Optimize Your Code

Instead of manually keying in the note frequencies and durations line by
line, we can optimize our code using a given sample code. This allows us
to compose a long melody easily.

To open the toneMelody sample code, go to
File > Examples > 02 Digital > toneMelody

sketch_dec10a | Arduino 1.8.10

File Edit Sketch Tools Help
New Ctrl+N
Open... Ctrl+O
Open Recent
Sketchbook
Examples Built-in Examples ’\' Qnce.s
Close Ctrl+W
Save Ctrl+S
Save As... Ctrl+Shift+S

01.Basics
02.Digital
03.Analog

Page Setup  Ctrl+Shift+P 04.Communication
Print Ctrl+P 05.Control

BlinkWithoutDelay
Button

Debounce
DigitallnputPullup
StateChangeDetection
toneKeyboard
toneMelody
toneMultiple {b

tonePitchFollower

06.Sensors
07 Display

Quit Ctrl+Q 08.Strings
09.USB
10.StarterKit_BasicKit
11 ArduinalSP

Preferences Ctrl+Comma

A VA VI VN VRS VIR VRS VISV RV

pitches
#define NOTEBS@i?

#define NOTE Cl1
#define NOTE CS1
#define NOTE Dl
#define NOTE DSl
#define NOTE El
#define NOTE F1
#define NOTE FS1
#define NOTE Gl

In the example given, every note's frequency is predefined from
note BO to DS8. You can click on pitches.h tab to view the
predefined note frequencies.
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toneMelody | pitches.h

#include "pitches.h"

// notes in the melody:

int melody[] = {

NOTE_C4, NOTE_G3, NOTE_G3, NOTE_A3, NOTE_G3, 0, NOTE_B3,
NOTE_C4

b

// note durations: 4 = quarter note, 8 = eighth note, etc.:
int noteDurations[] = {

4,8,8,4,4,4,4,4

b

void setup() {
// iterate over the notes of the melody:
for (int thisNote = 0; thisNote < 8; thisNote++) {

// to calculate the note duration, take one second divided by the
note type.
//e.g. quarter note = 1000 / 4, eighth note = 1000/8, etc.
int noteDuration = 1000 / noteDurations[thisNote];
(8, melody[thisNote], noteDuration);

// to distinguish the notes, set a minimum time between them.

// the note's duration + 30% seems to work well:

int pauseBetweenNotes = noteDuration * 1.30;
(pauseBetweenNotes);

/1 stop E;;e tone playing: This is the sample toneMelody sketch
! created by Tom Igoe. Upload this code to
} your Maker UNO X and you will hear the
} catchy ending of the song “Shave and a
Haircut, Two Bits”.

void loop() {
// no need to repeat the melody.

}
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2. Modify the sample sketch to play the first line of “Happy Birthday”
tune - replace the notes in the melody, their corresponding note
durations, and the total number of notes to play, as follows:

noteDurations

Project 10

#include "pitches.h"

// notes in the melody:

int melody[] ={

NOTE_G4, NOTE_G4, NOTE_A4, NOTE_G4, NOTE_C5, NOTE_B4
5

// note durations: 4 = quarter note, 8 = eighth note, etc.:
int noteDurations[] = {

8,8,44,4,4,2

b

void setup() {
// iterate over the notes of the melody:
for (int thisNote = 0; thisNote < 6 ; thisNote++) {

&

3. Compile and upload your code. Check your result.

Click here or scan
QR code to watch
the demo video.

E-ﬁ E Similar to Project 9, the buzzer will play
r

the first line of “Happy Birthday” tune one
time.

Simplifying Digital Making




toneMelody pitches.h

Import all the pitch values for typical notes
as defined in pitches.h

melody]] = {
NOTE_G4, NOTE_G4, NOTE_A4, NOTE_G4, NOTE_C5, NOTE_B4

|5

Define melody[ ] array with the notes to be
played in sequence.

noteDurations[] = {

8,8,4,4,4,4,2
I Define noteDurations [ ] array with the
corresponding note durations.

void setup() {
(int thisNote = 0; thisNote < 6; thisNote++) {
For loop to get the program to play each

note in sequence. 6 here refers to the
number of notes to be played.

noteDuration = 1000 / noteDurations[thisNote];
(8, melody[thisNote], noteDuration);

pauseBetweenNotes = noteDuration * 1.30;
(pauseBetweenNotes);

Similar to Project_9 code, this tells the
program to play each tone and then hold
for 30% longer of the note duration.

Stop playing any tone.




CODING SYNTAX

1. To use “for” statement:
for (initialization; condition; increment)

{

//statement(s)

}

Example:

void loop() {

digitalWrite(2,HIGH);

delay (1000); These lines of code from
digitalWrite(3,HIGH);
delay (1000);
digitalWrite(4,HIGH);
delay {1000); for (int i=2; i<8; i++)

Project_3 can be shortened into
just three lines using for
statement, as shown below:

digitalWrite(5,HIGH); {

delay (1000); digitalWrite (i , HIGH);
digitalWrite(6,HIGH); delay (1000);

delay (1000); }

digitalWrite(7,HIGH);

delay (1000);

}

2. When we have many variables of the same data type, we can
use an array and introduce all the variables using only one line
of code. To use an “array”:

type arrayName [ ] = { list of variables}
type: data type, e.g. int, char,
arrayName = any name which identifies the array

Example:
int melody[ ] = { NOTE_C4, NOTE_D4, NOTE_E4 }
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Task: Program your Maker UNO X to play a complete “Happy Birthday’
tune when the on-board switch is pressed.

Hap - py Dbirth - day

Click here or scan
QR code to watch
the demo video.

CONGRATULATIONS! You have completed Lesson 4 and learnt the
following:

How to program Maker UNO X to play tones.

How to compose a simple melody using Maker UNO X.
How to load a sample program from Arduino library.
How to use for statement.
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LESSON 5
ANALOG INPUT
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3. Write and upload the following code to your board.

Project_11

void setup() {
Serial.begin(9600);

}

void loop() {
Serial.printin(analogRead(A0));
delay(1000);

}

Once uploaded, click on the serial monitor button on the toolbar. A
new window will pop up on your screen. Make sure that the baud rate
is set to 9600 baud.

Autoscroll [_]Show timestamp ‘Newline ~| 9600 baud ? ~| | Clear output

Simplifying Digital Making




5. Observe the value displayed on the serial monitor window as you turn
the potentiometer clockwise, and then counter clockwise.

e 6 0 00608 08 08 0 0
“ 88 0000 08 0
e o 0 0 0 0

*s 08 0 0

e o 0

Cy fl‘ on ; In collaboration with
Technologies—

chynbala RIS OISR

fritzing

6. Check your result.

~
Click here or scan

QR code to watch
the demo video.

|- The values displayed on the serial monitor
are the analog readings provided by the
potentiometer. ’
N Y
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void setup() {
(9600); Setup serial communication

}

Read the analog value of pin AO
( and display the value in the
serial monitor window.

void loop() {

(1000); Wait for 1 second.

‘ }

ARDUINO FUNCTION

1. Only pins AO, A1, A2, A3, A4 and A5 have analog input function.
Hence, we need to connect analog sensors to these pins if we
want to get analog input values.

Digital input has only 2 possible values; either 0 (LOW) or 1
(HIGH).Analog input values range from 0 to 1023.
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L5 Project 12: Read Analog IR Sensor

Get ready these components.

Jumper wire , ® IR Sensor

2,

-y

-y

= r4

= i

<

= -

ra

- ra

~ 4

2 -

TXOP L=

RX0«0 -

= 2l @ gt

C}{'g{n’o ?gg s In collaboration with
chmbeka RIS OLFS

www.cytron.io

Ggran’>

fritzing

IR Sensor A0

Maker UNO X
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3. Upload the same program used in Project_11 to your board.

Project_12

void setup() {
Serial.begin(9600);

}

void loop() {
Serial.printin(analogRead(A0));
delay(1000);

}

Once uploaded, click on the serial monitor button. Place your hand in
front of the sensor. Observe the value displayed on the serial monitor
window as you move your palm towards the IR sensor, and then
away from it.

chymbaka QRIS OGS

fritzing
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5. Check your result.

~
Click here or scan

QR code to watch

the demo video. What do you observe? Does the IR

reading increase or decrease as you

E L E move the box towards the sensor?
What is the reading when you remove

Infrared (IR) Sensor

1.

An infrared (IR) sensor consists
of two parts - IR transmitter (IR
LED) and IR receiver
(photodiode).

When powered up, the
transmitter will emit IR light. If
there is an object placed in front
of the sensor, the IR light will be
reflected back to the receiver.

The intensity of the IR light
detected by the receiver is then
converted into an analog value
which you can observe in the
serial monitor window.

The IR reading changes in
proportion to the distance
between the object and the IR
sensor.

the box (no obstacle)?

IR Transmitter

IR Receiver

Distance: FAR - IR Reading: HIGH

IR Transmitter

IR Receiver
Distance: NEAR - IR Reading: LOW
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£5 Project 13 : IR Sensor to Detect Black Line

1. Get ready a piece of white cardboard and a black marker pen. Use
the black marker pen to draw a thick black line (about 2cm in width)
across the centre of the cardboard as shown below.

A

IZcm

10 cm

Fold the cardboard and place it in front of the IR sensor as shown
below. Fix the distance between the cardboard and the sensor at
approximately 2cm.

chynbaka RIS (LSS

fritzing
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3. Slide the cardboard horizontally, from one end to the other. Observe
and record the IR readings from the serial monitor when the IR
sensor is facing the white surface, and then the black line.

Condition IR Reading

White Surface

Black Line

4. Write the following code into a new sketch and then upload to your
board.

Project_13

int irValue;

void setup() {
Serial.begin(9600);
pinMode (3, OUTPUT);

}

void loop() {
Serial.printin(analogRead(A0));
irValue = analogRead(A0Q);
if (irValue > 500) {
digitalWrite (3, HIGH);
delay(200);
}
else {
digitalWrite (3, LOW);
delay(200);
}
}
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5. Check your result.

~
Click here or scan

QR code to watch
the demo video.

E E_‘ Did LED 3 light up when the black line is

detected? And go off when the white
surface is detected?

“‘irValue > 500” is the threshold for my case. You may need to change
the threshold value according to your readings in Step 4. You can
pick any value between the two conditions but it is good practice to
set the threshold value at midpoint.

You can use this formula to determine a suitable threshold value.

Threshold Value =

IR Reading when IR Reading when
facing WHITE surface <+ facing BLACK line

2
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@ How it works

OO0 HEE

Project_13

irValue;

vnid cot |n() {
(9600);
(3,
}

void loop() {

(

irValue =

(irValue > 500) {
(3,
(200);

Define a variable - “irValue”

Setup serial communication.
Set Pin 3 as output.

Read analog value of pin AO and
display in serial monitor.

Assign analog input of pin AO to
variable irValue.

Check irValue:

IF irValue > 500 (i.e. black line is
detected), turn on LED 3.

Hold for 200ms.

Else, turn off LED 3.
Hold for 200ms.
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Infrared (IR) Sensor

IR sensors are commonly used to detect obstacles and measure
distances. Besides that, we can also use IR sensors to differentiate
black and white surfaces.

This is because a white (or light coloured) surface is able to reflect
most of the light from the IR transmitter, while a black (or dark
coloured) surface tends to absorb the light. Hence the IR receiver
will detect comparatively more light reflected from a white surface
than a black surface.

IR Transmitter IR Transmitter

IR Receiver IR Receiver

BLACK Surface; WHITE Surface;
IR Reading - HIGH IR Reading - LOW

Applying this concept, we can use multiple IR sensors arranged in a
straight line to build a line follower robot.

sensor sensor
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CODING SYNTAX

In this project, the analog input value from the IR sensor keeps
changing depending on the colour of the object it is currently facing.
We need to store the value to a certain place and only summon it
when needed. To do that, we can assign a variable.

int variableName = value; OR int variableName;

variableName can be any word EXCEPT those already used as
keywords in Arduino IDE. You are encouraged to use descriptive
names, such as “irValue” or “distance”, so that you (or anyone
reading your code) can easily understand what the variable
represents.
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Task: Utilise the analog values from a potentiometer to change the
blinking speed for LED 3.

-
Click here or scan

QR code to watch
the demo video.

Of40

7= b

[=]

CONGRATULATIONS! You have completed Lesson 5 and learnt the
following:

How to read analog input.

How to use serial monitor.

IR sensor and how it works.
How to assign variable numbers.
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LESSON 6
DC MOTOR



£5 Project 14: Control a DC Motor

1. Get ready these components.

DC motor with blade

Diode
The terminal with a white
stripe should connect to 220 ohm resistor

the positive wire (red)

COLLECTOR
3

1
EMITTER

2N2222 Transistor
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2. Construct the circuit as shown below:

chmbaka RIS ELEER

fritzing

3. Write and upload the following code to your board.

Project_14

void setup() {
pinMode(2, INPUT_PULLUP);
pinMode(5, OUTPUT);

}

void loop() {
if (digitalRead(2)==LOW) {
while(1) {
analogWrite(5, 255);
delay(3000);
analogWrite(5, 80);
delay(3000);
}
}
else digitalWrite(3, LOW);

}
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4. Once uploaded, press the on-board switch and observe the result.

~WMd) 1V.119i0|

3|
Z|
=
=
O]
a
Z|

chymbaka RIS [z

fritzing

\
Click here or scan

QR code to watch

the demo video. When you press the switch, do you see the
motor starting to spin? It will continue to
spin continually, at full speed and then
medium speed alternately, until you power
off or press the reset button.
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Project_14
void setup() {

(2, 8l Set Pin 2 as input_pullup (switch).
(5, : Set Pin 5 as output.

}

void loop() {

( (2)== Check Pin 2 value. IF Pin 2 value =
(1)1 LOW (i.e. switch is pressed), always
(5, 255); set Pin 5 to 255 (motor spins at max
(3000); speed) for 3 seconds,
(5, 80); then set Pin 5 to 80 (motor spins at
(3000); medium speed) for 3 seconds.

Else set Pin 5 to LOW (motor is
turned off; not spinning).

Make sure the DC motor is supported. The motor may not have
sufficient torque to spin if the blades are resting on a surface.

Turn on the Debug mode and observe the built-in LED at Pin 5.
After the switch is pressed, the LED should alternately light up at
full brightness for 3 seconds and then dim for another 3 seconds.

If #2 above is working but the motor is still not spinning,

you need to check your circuit and make sure that all
components are connected correctly.
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How to Control a DC Motor Speed?

To get a DC motor to spin, you need to apply suitable input voltage to
it. The typical input voltages for DC motors are 3V, 6V adn 12V. The
motor manufacturer will usually indicate the recommended input
voltage in the product specifications.

Nevertheless, motors can still work even when you apply lesser or
greater voltage than recommended. For the DC motor that we are
using in this project, the recommended voltage is 3-6V. Let's try to
apply 3.3V and 5V and see what happens.

Black wire is connected to GND Black wire is connected to GND
and red wire to 3.3V pin. and red wire to 5V pin.

We can observe that the speed of the DC motor changes with the
input voltage. The higher the input voltage, the faster the motor spins.
Thus in Project 14, when we set pin 5 value to 255, the motor spins
at full speed and then it slows down when pin 5 value is set to 80.

WARNING! Applying high voltage to a motor (beyond the
recommended voltage) will shorten a motor's life cycle in
the long run.

Simplifying Digital Making




How to Control a DC Motor's Spinning Direction?

To change the spinning direction is easy - simply reverse the polarity
of the motor by switching the red wire and black wire connections.

Black wire is connected to GND Black wire is connected to 5V pin
and red wire to 5V pin. and red wire to GND.

Do you observe that the motor spins in the opposite
direction when we switch the wire connection?

Nevertheless, it is impractical to manually switch the wire connections
each time you want to change the spinning direction. In order to easily
control both the spinning direction and speed of a DC motor (without
modifying the circuit), we can use a motor driver, such as the following.
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Project 15: Controlling Motor Speed Using A Pushbutton

Write the following code and upload to your board.

Project_15

int mode =0;

void setup() {

pinMode(2, INPUT_PULLUP);
pinMode(5, OUTPUT);

}

void loop() {

switch(mode) {
case O:
analogWrite (5, 0);
break;

case 1:
analogWrite (5, 100);
break;

case 2:
analogWrite (5, 255);
break;

default:
mode = 0;
break;

}

if (digitalRead(2)==LOW) {
while(digitalRead(2)==LOW);
mode++;

if (mode==3)

mode=0;

}
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3. Once uploaded, press the on-board switch and observe the result.
Repeat several times and observe changes to the motor speed each
time the switch is pressed.

\
Click here or scan

QR code to watch
the demo video.

When you press the switch, the motor starts
=3 spinning. And if you press again, the motor
Eﬁ. E spins faster (at full speed). The third time
I' you press the switch, the motor stops
& spinning.

-




@ How it works

Q0O

Project_15
mode = 0;

void setup() {
(2,
(5,

}

void loop() {
(mode) {
0;

Define a variable named “mode”
and set the initial value as 0.

Set Pin 2 as input_pullup (switch).
Set Pin 5 as output.

Set conditions for various cases
and statements to be executed
when each condition is met.

If mode = 0, motor at pin 5 runs at
speed 0 (i.e. not spinning)

If mode = 1, motor at pin 5 runs at
speed 100 (i.e. spinning slowly)

If mode = 2, motor at pin 5 runs at
speed 255 (spinning at full speed)

If mode is neither 0,1 or 2, set
mode to 0.

If Pin 2 switch is pressed,

check Pin 2 switch again and wait
until it is released.

Update mode value by +1.

If mode = 3, update mode value to
0.




CODING SYNTAX

1. Like if statements, switch...case controls the flow of a program
by allowing programmers to specify which lines of code to be
executed when the set conditions are met. This is useful when
you need to use the same switch to execute different sets of

program.

switch (var) {

case 1:
//do something when var equals 1
break;

case 2:
//do something when var equals 2
break;

default:
/I if nothing else matches, do the default
// default is optional
break;

}

2. To stop the motor from spinning, you can write either of these:

digitalWrite (pin, LOW);
or

analogWrite (pin, 0);
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3. Did you notice that we didn't put a semicolon ; after while(1) in
our previous projects but we added a semicolon after
while(digitalRead(2)==LOW) in this project?

Without “; “

while (condition) {

//if the condition is true, program will run all lines of code
inside { }

}

With ; “

while (condition) ;
//if the condition is true, it will only run this line until the
condition becomes false.

Example:

while(digitalRead(2)==LOW);

// If switch 2 is pressed (condition is true), the program will
stay at this line of code until switch 2 is released (condition
becomes false). Then, and only then will it move on to execute
the next line of code.
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Task: Program the motor to run at a constant speed when you press and
hold the pushbutton. The motor stops when you release the button. And
when you press the pushbutton for the second time, the motor's speed
will change.

\
Click here or scan

QR code to watch
the demo video.

CONGRATULATIONS! You have completed Lesson 6 and learnt the
following:

1. How to construct a circuit to run a DC motor.
2. How to control a DC motor speed.
3. How to use switch..case statement.
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LESSON 7

ULTRASONIC
SENSOR



£33 Project 16: Setting Up Ultrasonic Sensor

1. Get ready these components.

Ultrasonic Sensor

2. Construct the circuit as shown below.

0 ' 1 RESET]

~WMd) T1V.LI9Ia]

EELN

NI DOTYNY|

0

chmbaka  FRUS GOS8

Ultrasonic
Sensor

fritzing

GND

Maker UNO X GND
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Connect the sensor at the edge of the breadboard
and ensure that the jumper wires are not blocking
the sensor.

3. Write and upload the following code to your board.

Project_16

long duration;
int distance;

void setup() {
(11, OUTPUT);
(12, INPUT);
(9600);

}

void loop() {
(11, LOW);
(2);
(11, HIGH);
(10);

(11, LOW);
duration = (12, HIGH);
distance = duration*0.034/2;

(50);
(“Distance = “);
(distance);
(“ecm “);
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Once uploaded, click on the serial monitor button to view the result.
Place your hand in front ot the sensor. Observe the value displayed
on the serial monitor window as you move your palm towards the
ultrasonic sensor, and then away from it.

= TOREF
RESET

cytron.io

www.c)

chmbaka MROS (580

Check your result.

N
Click here or scan

QR code to watch
the demo video. What do you observe? Does the ultrasonic
reading increase or decrease as you move
E E the box towards the sensor? What is the
- reading when you remove the box (i.e. no
obstacle)?
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@ How it works

OO0 BEA

Project_16

duration;
distance;

void setup() {
(11, );
(12, );
(9600);
}

void loop() {
(11,

(11,

(11,

duration = (12,

distance = duration*0.034/2;
(50);

(

(distance);

( );

Define “duration” as a long variable.
Define “distance” as an integer.

Set Pin 11 (trigger pin) as output.
Set Pin 12 (echo pin) as input.
Set up serial monitor (9600 baud)

Set Pin 11 (trigger pin) to low.
Delay for 2 microseconds.

Set Pin 11 to high (emit signal).
Delay for 10 microseconds.
Set Pin 11 to low again.

Check the pulse duration at Pin 12
(echo pin) and assign that value to
variable “duration”.

Convert that value of “duration” into
distance in cm. Hold for 50ms.

Print “Distance = “ in serial monitor
window, followed by “distance value’
and then “cm”.

B




6. Next, let's modify your previous program into the following and then
upload to your board again.

Project_16a

long duration;
int distance;

void setup() {
pinMode(11, OUTPUT);
pinMode(12, INPUT);
Serial.begin (9600);

}

void loop() {

ultrasonic ();

Serial.print (“Distance = “);
Serial.print (distance);
Serial.println (“cm “

}

void ultrasonic() {
digitalWrite(11, LOW);
delayMicroseconds(2);
digitalWrite(11, HIGH);
delayMicroseconds(10);
digitalWrite(11, LOW);
duration = pulseln (12, HIGH);
distance = duration*0.034/2;
delay(50);

}
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Check your result.

\
Click here or scan

QR code to watch
the demo video.

[=] 5[]

- You should get the same result as the
earlier program.

Project_16a

void loop() { Call the “ultrasonic” function (i.e.
ultrasonic (); execute all the lines of code in the
WS EREERIE function “ultrasonic”.)
(distance);
(“cm “);

ultrasonic() {

11, ;
( (2)). These lines of code have been
(11 )'. grouped into a function named

)

(10); “ultrasonic”.

(11, );
duration = (12, );
distance = duration*0.034/2;

(50);
}
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Ultrasonic Sensors

Like IR sensors, ultrasonic sensors are used to detect obstacles and
measure distances.The working mechanism is also similar to IR
sensors. The transmitter emits an ultrasonic wave, which upon hitting
an object in its path, is reflected back and detected by the receiver.

By calculating how long it takes for the reflected wave to be detected,
we can determine the distance of the object from the sensor.

Transmiter

t =Time travel of the sound wave in ps

Speed of Sound =343 m/s = 0.034cm/ps
:::(ijii% Distance = % x Speed of Sound
. = L x0034cm
2
< >

Receiver Gkt =tx0.017 cm

Ultrasonic sensors are widely used as car reverse sensors to help
drivers to estimate distance and detect obstacles. The advantage of
an ultrasonic sensor over an infrared sensor is its insensitivity to the
surrounding lighting.

However, ultrasonic sensors may not work as expected if the object is
(i) too far away, (ii) too small, (iii) too soft or (iv) the object bounces
the sound wave away from the receiver.
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ARDUINO FUNCTION

1.  You can use this function to read the time cycle of a pulse.

pulseln (pin, value)

pin: the number of the pin on which you want to
read the pulse.

value: type of pulse to read; either HIGH or LOW

If the value is set to HIGH, pulseln() waits for the pin to go from
LOW to HIGH, starts timing, then waits for the pin to go back to
LOW and stops timing. It returns the length of the pulse in
microseconds.

Data type
You may ask why most of the time we use “int” (integer) to define
a variable but in this project we are using “long” instead. This is
because we need to inform Arduino what kind of number we
want to store in the variable - whether it is a small number, a
large number, or a number with decimal points, etc. In this
project, the number we need to store for 'duration’ is large.
Variable Number Range

char -128 to 127
int -32,768 to 32,767
long -2,147,483,648 to 2,147,483,647

float 3.4028235E+38 to 3.4028235E+38
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Project 17: Build a Car Rear Bumper Sensor

Modify your code in Project 16 to the following:

Project_17

long duration;
int distance;

void setup() {
pinMode(8, OUTPUT);
pinMode(11, OUTPUT);
pinMode(12, INPUT);

}

void loop() {
ultrasonic ();
if (distance < 2) {
tone(8, 349);
}
else {
tone (8, 349);
delay(50);
noTone(8);
delay(distance*10);

}
}

void ultrasonic() {
digitalWrite(11, LOW);
delayMicroseconds(2);
digitalWrite(11, HIGH);
delayMicroseconds(10);
digitalWrite(11, LOW);
duration = pulseln (12, HIGH);
distance = duration*0.034/2;
delay(50);

}
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Upload the code to Maker UNO X and check your result.

Click here or scan

QR code to watch

the demo video.

\

Does the piezo buzzer beep repeatedly
when the sensor detects an obstacle?

Do you notice that the beeping intensifies
(i.e. the frequency of the beeping
increases) as the sensor is moved nearer
towards the object?




Project_17
long duration;
int distance;

void cnhln() {
(8, );
(11, OUTPUT);
(12, INPUT);

}

void loop() {
ultrasonic ();

(distance < 2) {
(8, 349);

{
(8, 349);
(50);
(8);
(distance*10);
}
}

void ultrasonic() {
(11, LOW);
(2);
(11, HIGH);

(10);

(11, LOW);
duration =

(50);
}

(12, HIGH);
distance = duration*0.034/2;

Set pin 8 (piezo buzzer) as output.

Call the “ultrasonic” function.

If distance is less than 2cm,
buzzer will play note F4 (349) continually.

Else, buzzer will beep note F4 (349) at
an interval of 'distance x 10" milliseconds.
E.g.: When distance = 5cm, the buzzer
beeps once every 50ms.

When distance = 10cm, the buzzer
beeps once every 100ms.
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Do you know?
“The theremin is an electronic musical instrument controlled
without physical contact by the thereminist (performer). It is
named after its inventor, Léon Theremin, who patented the
device in 1928.”

Source: https://en.wikipedia.org/wiki/Theremin

Task: Build a Theremin using your Maker UNO X and the ultrasonic
sensor. Divide the ultrasonic sensor's sensing range into a few zones to
play different tones.

d -+ )\ N
Click here or scan Click here or scan

QR code to watch QR code to watch
the demo video. a Theremin show.

CONGRATULATIONS! You have completed Lesson 7 and learnt the
following:

1. How an ultrasonic sensor works.
2. How to create self-declared functions.
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CONGRATULATIONS!

Vou've completed all lessons and mastered the basics. We hope that you've had fun

alongy the way.

However, this isn'+ the end of your journey with Arduino. with the kvowledge and
skills you've acquired, you're well on your way to building your own projects!

For more project ideas, you cam Visit our tutorial page or follow us on Facebook. Tf
you need more components, you can explore and get them from Cytron webstore -
*free shippivg for teachers avd studewts!

Remember to share our creations with us if you'd like to be featured or just drop us

a message anvytime. We'd love +o hear from voul

Cheers~

N 7
Click here or scan Click here or scan

QR code to visit QR code to visit
Cytron Webstore. Tutorial Page

-
1FE

\

N
Click here or scan
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QR code to follow
Cytron FB Page

Update us
on your
progress!
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